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Objectives

1. Identify 5 modifiable risk factors for dementiaacross lifespan

2. Develop strategiesto emphasize overlappingrisks for heart attack,

stroke & dementia

3. Practice Ml skills for risk reductionand dementia prevention

Providence @ SWEDISH



Age-Friendly (whole person) Health

Providence Swedish 5 Ms for Age- Friendly

Systems (AFHS) onlth

Know your care preferences and set
goals for your health. Establish Advance
Directives and Trusted Decision Makers.

WHAT MATTERS

Manage your medications and
understand how they may impact your
mobility and cognition.

MEDICATION

Get the emotional and cognitive support
you need. Understand, prevent, and seek
treatment for dementia, delirium, and

depression.

MENTATION

Keep active and mobile, preventing
injuries and falls. Learn how to safely

mobilize as you age.

MOBILITY

Commit to proper nutrition and assess Providence 3, SWEDISH

malnutrition risk regularly.

MALENUTRITION
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What is brain health and why is it important? A new definition of brain health

Vladimir Hachinski £ « Abolfazl Avan « Jason Gilliland « Shahram Oveisgharan

Yongjun Wang and colleagues discuss the definition of brain health and the opportunities and
challenges of future research : :
Published: May, 2021 « DOI: https://doi.org/10.1016/S1474-4422(21)00102-2

Brain health is defined as the state of brain functioning
across cognitive, sensory, social-emotional, behavioral &
motor domains allowing a person to realize their full
potential over the life course

More importantly, irrespective of the presence or absence
of a disease & seen through the interconnected SDOH

WHO (2021)
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Optimal cognitive, mental and social function

Promoting factors
Protective factors
Healthy environment
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Environmental,
Social,
Political,
Economic,
Individual

Risk factors

Loss of cognitive, mental and social function

DEMENTIA

40th Anniversary: Review

Neuroepidemiology 2022;56:151-156 Received: March 2,2022

. Accepted: May 22, 2022
DOI: 10.1159/000525219 Published online: May 25, 2022

From Dementia to Eumentia: A New
Approach to Dementia Prevention

Vladimir Hachinski® ® ¢ Abolfazl Avand €

Comprehensive, customized,
cost-effective approach to prevention
of stroke, heart disease & dementia

Presentation Title Here = Insert = Header & Footer 2



OPINION

Brain health and shared risk factors
for dementia and stroke

Hannah Gardener, Clinton B. Wright, Tatjana Rundek and Ralph L. Sacco

modifying brain reserve, tolerance to ischemia
(APOE, BDNF etc.)

predisposing to clinical stroke

?

Vascular MCI, VaD influencing specific imaging and cognitive

markers of VCID
Amyloid Angiopathy

White Matter Disease

large artery small vessel
atherosclerosis disease

1 risk of and susceptibility to

HTN LDL-chol smoking
Vascular and lifestyle risk factors

DM obesity ?

HTN - the most significant of all

1in 3 of middle-aged adults

1in 2 by 2025

Felgin VL, Lancet Neurol. 2021

Mat Rev Neurol. 2015 Nov
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Early life
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Midlife

Percentage reduction in dementia prevalence
if this risk factor is eliminated

Later life

Risk Factors:

40% of dementia cases are preventable
across the lifespan.1é

Non-modifiable risk factors:
Age, family history, genetics
APOE 4 allele7-1?
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CDC's National Center for Chronic Disease Prevention and Health Promotion INCCDPHP)

CHRONIC DISEASES IN AMERICA 4 »

6in10

Adults in the US
have a chronic disease

410

Adults in the US
have two or more +

.
..Q

THE LEADING CAUSES OF DEATH AND DISABILITY
and Leading Drivers of the Nation's $4.1 Trillion in Annual Health Care Costs

L x ﬂw! B o9

HEART DISEASE CHRONIC LUNG ALZHEIMER'S DIABETES CHRONIC
DISEASE DISEASE KIDNEY DISEASE
[~
.
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M . ¥
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Mixed Dementia

* Rule, not the exception
* 98% of early onset cases with 2 pathologies

* 100% of late onset cases with 3 pathologies
* Cerebral amyloid angiopathy= 79-86%
* Lewy Body disease =42-49%
e Differences for amygdala predominantLBD

* Mixed AD and VaD

* Most frequent form of mixed dementia in late onset
* 65%vs 39%

* 28% in dementia clinics

* >50% in community samples

* Periventricular lesions in 90% of AD cases

- JIL . .
Prowdence F'{FSpir%»yE?chﬁel-lR, Petersen C, et al. Comorbid neuropathological diagnoses in early versus late-onset AIzheﬁﬁeésregtg}'soga-sré”.eB'-r'aelrﬁ. 38??1\6ng75‘1"‘£&73°5&%6-21982



Healthy lifestyle and life expectancy with and without Alzheimer’s dementia:
population based cohort study

BMJ 2022 ;377 doi: https//doi.org/10.1136/bmj-2021-068390 (Published 13 April 2022)
Cite this as: BM/ 2022.377:e068390

Women

T
o
o

— Zero or one healthy factor
Two or three healthy factors
----- Four or five healthy factors

(o) @
o o

D
o

Proportion of life expectancy
with Alzheimer’s dementia

-Nonsmoking

->2150 min/wk moderate/vigorous-intensity

physical activity

-light to moderate alcohol consumption s

-high-quality Mediterranean-DASH Diet EE

Intervention for Neurodegenerative Delay gé

diet (upper 40%) %

-Engagement in late-life cognitive activities 5 E

(upper 40%) é%
o.

4-5 healthy factors “60% lower risk of AD
65 70 75 80 85 90 95 100

Age (years)

2449 MEN AND WOMEN AGE 65 AND OLDER

See this image and copyright information in PMC
Fig 2 Proportion of life expectancy spent with Alzheimer's dementia according to categories of
lifestyle score in women and men. Proportion is computed by dividing life expectancy lived with

Alzheimer’s dementia by total life expectancy at a given age (supplementary tables 2 and 3). A PrOVidence :_:% SWEDISH

behavior was classified as low risk or healthy if it met several criteria: Mediterranean-DASH Diet
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Review > Ageing Res Rev. 2020 Mar;58:101002. doi: 10.1016/j.arr.2019.101002.
Epub 2019 Dec 30.

A Third of Community-Dwelling Elderly With
Intermediate and High Level of Alzheimer's
Neuropathologic Changes Are Not Demented: A
Meta-Analysis

Mahmoud Reza Azarpazhooh 1, Abolfazl Avan 2, Lauren E Cipriano 2, David G Munoz 4, Mahdiyeh
Erfanian ®, Amin Amiri ©, Saverio Stranges 7, Vladimir Hachinski 8
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586 brain autopsies of people who had a mean age
of 90.9 years at the time of death, Lifestyle habits
linked to dementia risk more than amyloid plaques
or abnormal blood flow in their brains.

Partficipants in this study had registered with RUSH
University’s Memory and Aging Project. Individuals
self-reported their lifestyle habits.

> JAMA Neurol. 2024 Feb 5:2235491. doi: 10.1001/jamaneurol.2023.5491. Online ahead of print.

1. Smoking

2. At least 150 min physical acfivity/wk Healthy Lifestyle and Cognition in Older Adults With
3. Limited alcohol Common Neuropathologies of Dementia

4' MIND dleT score Klodian Dhana ' 2, Puja Agarwal 2 3, Bryan D James 2 3, Sue E Leurgans * #, Kumar B Rajan ! 2,
5. Cognmve Activities Neelum T Aggarwal * 4, Lisa L Barnes * 4, David A Bennett 3 “, Julie A Schneider 3 # 3

The researchers estimated that just 12% of cognition-
related measurements were affected by amyloid
plaques.
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Healthy lifestyle and the risk of Alzheimer

dementia

Findings from 2 longitudinal studies

Klodian Dhana, MD, PhD, Denis A. Evans, MD, Kumar B. Rajan, PhD, David A. Bennett, MD, and

Martha C. Morris, ScD

Neurology ® 2020;95:1-10. doi:10.1212/WNL.0000000000009816

Correspondence
Dr. Dhana
klodian_dhana@rush.edu

Figure HRs of AD according to the combination of healthy lifestyle factors in the prospective cohort studies

Number of healthy

lifestyle factors N % of AD Hazard ratio (95% Cl)
0-1 healthy factor :

CHAP 0-1 322 24.4 [ ] 1.00(1.00, 1.00)
MAP 0-1 123 31.7 . 1.00 (1.00, 1.00)

2-3 healthy factors

CHAP 2-3 1,073
MAP 2-3 507

Combined (p for heterogeneity = 0.7)

4-5 healthy factors

CHAP 4-5 450

MAP 4-5 290

Combined (p for heterogeneity = 0.5)

15.4

26.4 +
.

0.58(0.37, 0.93)

0.66 (0.46, 0.94)
0.63(0.47, 0.84)

193 _
R
i

| I i \
0.10 025 050 100  2.00

Hazard ratio

0.33(0.18,0.61)
0.43(0.28, 0.66)
0.40(0.28, 0.56)

Model adjusted for age, sex, race, education, APOF €4, and prevalence of cardiovascular disease (including heart disease or stroke). A random-effects meta-
analysis was used to combine cohort-specific results. AD = Alzheimer dementia; CHAP = Chicago Health and Aging Project; Cl = confidence interval; HR =
hazard ratio; MAP = Rush Memory and Aging Project; N = number of participants in each group.

Nonsmoking, 2150 min/wk moderate/vigorous-intensity physicalactivity, light to moderate alcohol consumption, high-quality Mediterranean-DASH Diet Intervention for Neurodegenerative Delay diet (upper 40%),

a%e ng&WﬁmsHife cognitive activities (upper 40%)
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. . Adherence to a healthy lifestyle
E p | g en et| CS can offset genetic risk

Genetic Risk, Lifestyle and Dementia

360%
60%
Population - <30%
Risk
Genetic risk Genetic risk Genetic risk
+ +
unhealthy lifestyle lifestyle

Kuzma et al. Alzheimer & Dementia, 2019
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McCANCE MASSACHUSETTS
GENERAL HOSPITAL

* Brain Care Score eCaver cavx

2 Front Neurol. 2023 Dec 1:14:1291020. doi: 10.3389,/fheur.2023.1291020. eCollection 2023. o

The predictive validity of a Brain Care Score for
dementia and stroke: data from the UK Biobank

Category Criteria / Description m

Resting blood pressure greater than 140/90, with or without treatment

gll:::urc Resting blood pressure 120-139/80-89, with or without treatment 2
Resting blood pressure less than 120/80 3
c D h 0 rt Hemoglobin Alc greater than 6.4 0
Blood Sugar Hemoglobin Alc between 5.7 and 6.4 1
Hemoglobin Alc less than 5.7 1)
Physical 190 or higher 0
Cholesterol No treatment required or less than 190 mg/dL 1
If cardiovascular disease is present, LDL is in accordance to the latest CDC recommendations 1
Lower than 18.5 kg/m? 1
BNl 18.5-25 kg/m* 2
25-29.9 kg/m? 1
Greater than 30 kg/m’ 0
Dietary habits:
« 4.5 servings of fruit and vegetables per day;
2 servings of lean protein per day
* 3 or more servings of whole grains per day
Less than 1,500 mg of sodium per day
. . Nutrition Less than 36 oz of sugar sweet beverages (soda, juice, etc.] per week
Results: The BCS (median: 12; 1QR:11-14) was derived for 398,990 Tyical weekydet doe nt include alast2fthe ecommendations above 0
1~1 . . f I . (y ) ‘ Typical weekly diet includes 2 or more of the recommendations above 1
U KB pa rtICIpa nts (mea n age. 57’ ema es. 54 0). Typical weekly diet includes 3 or more of the recommendations above 2
5,354 incident cases of dementia, 7,259 incident cases of stroke = ﬂ
. . S Alcohol 2-3 alcoholic drinks per week 1
recorded during a median follow-up of 12.5 years. :
. . . . . . Current smoker 0
A five-point higher BCS at baseline was associated with a 59% Mg e e :
lower risk of dementia among participantsaged <50. Among those s Lass than 160 minates of odecate or 75 mistes of igh ntensity physical actvy per wesk 0
aged 50-59, the figure was 32% and 8% for those aged >59 years. A T R s T ety |
five-point higher BCS was associated with a 48% lower risk of St IR, Bt e oy 10 1 :
« . o Treated sleep disturbances and 7-8 hours of routine sleep per night 1
stroke among participants aged <50, 52% among those aged 50-59, T D
a n d 33% a m o n g t h Ose a ged >59 . Stress Moderate level of stress that occasionally makes it difficult to function 1
@ Manageable level of stress that rarely makes it difficult to function 2
Social . I have few or no close connections other than my spouse or children 0
Emotional éz‘iéi,lonsh.ps I have at least two people, other than my spouse or children, that | feel close with and could talk 1
about private matters or call upon for help
Meaning | often struggle to find value or purpose in my life 0
in Life I generally feel that my life has meaning and/or purpose 1

- f’.\
r d @ Sw E D I s H The components above reflect the latest, scientific based key contributors to brain health. Ti i
mponent latest, fi p i - otal Brain Care Score [0-21
F. rOV]. ence Q) it is important to discuss your score with a healthcare professional [ }

McCance Brain Care Score™ 2020, © The General Hospital Corporation, All rights reserved.




<Lifestvle Medicine for all (DM, CVD, Stroke/VCI)>

NUTRITION

3 common diets associated

with cognitive & stroke
protection: by 30%
DASH, MEDI, MIND

SLEEP HEALTH
<6h or >9h — higher risk

OSA- higher risk by 30%

Prolonged naps
Prolonged Insomnia
Interrupted sleep

Loneliness & social
1solation = increased risk
of stroke, recurrence,
dementia (~40%)

Lifestyle
Medicine
Pillars

PHYSICAL ACTIVITY

Low PA -20%

Moderate PA ~ 30%
Higher levels of PA-43%
stroke risk reduction,
compared to inactivity

Stress strongly linked
with higher risk of HTN,
stroke, cognitive
impairment, dementia/AD

SUBSTANCE USE

Middle aged smoking =
higher risk of cognitive

9 - 1mpairment later in life



Figure 2. Probable Dementia by Treatment Group

Trial and
Trial phase cohort phase Cohort phase
0.20+
o 0154
e
=
™, Standard treatment
%o,w
5 Intensive treatment
0.05
0 v g ' — ' e
0 1 2 3 4 5 6 7 8
Follow-up, y
No. at risk
Standard treatment 4285 4282 4168 3886 2829 2107 589 87 0
intensive treatment 4278 4277 4171 3917 2893 2189 1027 93 0

SPRINT-MIND JAMA 2019

SBP <120 assc with decreased risk MCI, fewer white matter lesions, total brain volume and no difference in stroke types based on treatment in subsequent

| 2021
Providence % SWEDISH

Shaded regions indicate 95%
confidence intervals. Median
follow-up time was 514 years
(interquartile range, 3.91-6.00) for
the intensive treatment group and
5.07 years (interquartile range,
3.87-598) for the standard treatment
group. For group comparison of
incidence, hazard ratio, 0.83; 95% ClI,
0.67-1.04; P=10.
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1 Physical Activity Stress Resiliency

Il Time Outs

B Investigations

3] Nutrition S HE

ocia
G m S Connection

PHYSICAL ACTIVITY

Engagement in any type of PA has been shown to
reduce stroke risk & the progression of cognitive

decline or dementia.

- enhances neuronal connections, maintain neuronal plasticity
and improve the release of neurotrophic factors (BDNF -

protein that builds the connections & memory)

- A large meta-analysis -

~ 30% less stroke/mortality with moderate to high PA,

~ 20% with leisure-time PA when compared to inactivity.

Jaqua E, Biddy E, Moore C, Browne G

T'he Impact of the Six Pillars of Lifestyle Medicine

S|mi|ar f|nd|ngs on PA and VCl on Brain Health. Cureus [Internet]. 2023 Feb 3
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z-Transformed PACC Score

Physical Activity Moderates the Association of
Amyloid B with Cognitive Decline

@ Physical exercise t BDNF Hippocampal
Lower physical activity Higher physical activity
05+ 0s
L e v R
of —— § o ) ———— J t Synaptic plasticity
e b] : ; Hippocampal volume
0.5+ . Blood brain barrier
& \\\ & 05 \ $Hippocampal Neurogenesis
- \\_\\ g o o '\ N JNeuroinflammation
sl S 15 | = Lower AB burden | |&.’ o o °®
: LI [===Rhm/ i | — | i
204 1 . : 206 : I y : —» Hepatokine Q@ ,_®
"o 2 4 5 8 0 2 4 6 8
Tine Since Baseline, y Time Since Baseline, y olccinocdi 2 B e o
Wi \ e® o ©
<
| - \ 0% °
A ® 9 o
. R, 0 o o
Rabin et al, JAMA Neurol, 2019. @ Muscle ~/’ i s
. . e o0 o °
) . . Chow et al, Nature Reviews Endocrinology 2022 A ;; °®
Fig. 1: The systemic effects of exercise. —» Myokines ,” .-~ N °
From: Exerkines in health, resilience and disease @ Irisin "/ '/ %
a b CTTE SRS S R LV B
i ‘ a? BOTEE ¢ hommt, O nsaee T TS
‘ )i ®lactate’ " T=-=- - -
oA ®
¥,
A AT
0
Exercise Exéicise Review > Front Aging Neurosci. 2022 Aug 31;14:965190. doi: 10.3389/fnagi.2022.965190.
; I—Jﬁ eCollection 2022.
HERESREE » Cardiovascular * Healthspan
disease * Longevity
Cardiometabolic tissues

U ‘ot - Restone The emerging neuroprotective roles of exerkines in

decline
/ oF : 's di
Cé% N a? £ o Alzheimer's disease
Cardiovascular  Adipose Endocrine Liver Skeletal

system tissue system muscle . . .
Tayna Rody 1, Julia A De Amorim 1, Fernanda G De Felice 1 # 3 ¢
a|Organs and tissues that can serve as source of exerkines and that are directly affected by exercise. b | Exercise results in profound health benefits,

including reductions in the presence or severity of certain diseases, as well as increases in healthspan, longevity and resilience. T2DM, type 2 diabetes
mellitus.

Providence @ SWEDISH
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Exercise and Physical Activity and Dementia

 Over 90 meta-analyses in the last 5 years
* Highest quality/most consistent evidence
e Likely multiple mechanisms of action (wilckens et al., 2021, Hippocampus)

* Likely beneficial in multiple domains
— Cognition (processing speed, EF>memory) (Wanget al., 2020, Aging)
— Physical function/mobility/falls (Lai et al., 2019, AMJ Phys Med Rehabil)
— Sleep (0’cacimhet al., 2019)
— Neuropsychiatric symptoms (watt, et al, 2021, BMJ)

* Likely most beneficial in combination with other NPTs

Pooled effects highest for delaying onset>MCI>dementia
— Group > individual

— Across settings, including home-based (de Aimeida, 2020, Gerontologist)
PrOVidence =7 SWEDISH Presentation Title Here > Insert > Header & Footer 2



Exercise and Physical Activity

e Should be recommended to adults with normal cognition to reduce the risk of cognitive decline.

— Quality of evidence: moderate

— Strength of the recommendation: strong RISK REDUCTION
OF COGNITIVE DECLINE
AND DEMENTIA

WHO GUIDELINES

 May be recommended to adults with MCI to reduce the risk of cognitive decline.
— Quality of evidence: low
— Strength of the recommendation: conditional

e 150 min of moderate-intensity or 75 min vigorous-intensity /week
— Double for additional health benefits

e Aerobic activity = 10+ minutes’ duration

*  Poor mobility = balance and fall prevention on 3+ days/week

*  Muscle-strengthening = major muscle groups on 2+ days/week

* Limitations = as physically active as abilities and conditions allow

g’/ ¢ \ﬂg World Health
W% Organization

————

PmVidence 3= SWEDISH Presentation Title Here > Insert > Header & Footer
World Health Organization, 2019



How to Implement

Schedvuling and structure

Create accountability
Classes

Exercise pariner(s)

PT/Trainer

Exercise Diaries
FitBit/exercise trackers
Check in calls

Program for variability and engagement
Graduated, well-paced incremental increases
Motivational interviewing/enhancement-SMART goals

“You know why | want you to exercise, why do you want to?”

“From ‘not.at dll’ to ‘very,” how likely are youto 7 What would get you to
Providence ! ‘*{* SWEDISH Presentation Title Here > Insert > Header & Footer 2



Lifestyle Change: Getting started

 Most individuals have multiple lifestyle goals.

* Your agenda and excitement about food,
exercise, stress, etc.. is not the most
important.

* The patient-driven agenda is paramount.

 Don’t ask “What's the Matter with you?”

* Rather: “What Matters to you?”

. N
Pr OVIdence @ SWEDISH 2 Presentation Title Here > Insert > Header & Footer 2



Optlonal Subhead here

Small strength training or aerobic exercises throughout the
day:

wall push ups, chair squats, a S minute walk

Small amounts of strength training helps patients build Exe®B.cise
confidence to do more. is Medicine’

Exercise improves energy, motivation, and mood helping to Physi
get the person into a victorious cycle.  lsomevhat hard &

MName:

< of moderate-intensity activity or 75-150 minutes/week of vigerous activity
el) or a combination of bath

Frequency (days/weelk):
Intensity: O Light (casual
Time {minutes/day): = 10 = 20 o 30 = 40 b 50 = &0 or more

walk) O Moderate {brisk walk) O Vigorous {like jogging)

Type: 2 Whll J Run 1 Bl LD Swim/Water Exercise  Oither
Stepa/day: O 2,500 Q5000 Q7500 0O10,000or more O Orther
What about aerobic activity?

* Moderate activity is at a ] ce where you can talk but cannot “sing.” Examples: frick waliing.,
Ln-.1 ARSI,

> J Neurol Neurosurg Psychiatry. 2022 Apr;93(4):343-350. doi: 10.1136/jnnp-2021-327396.
Epub 2021 Dec 21.

gees tivity in done ut o puce w hr_n. yoou cnn’t sy more thun o few vu.rla without
pul:.-mi. for a breath. J'.xar1|:‘1<.- J'c's.,., frogr, sxefm g, tenerir and fasr Sioyofing.

Frailty, lifestyle, genetics and dementia risk + You ean evereiss for any length of tims. For axanple, you might wallo

= 30 mine ela \."/n't..':.']‘_ or

= 1) rramuares daily

I il 2 fee hA B 2 v 14 = ’ .
David D Ward , Janice M Ranson #, LIndS:y M K Wallace , David J Llew e|| n> 3 =5 minutes here, 10 minutes there. Just work your way up to 150 total minutes/week.
Kenneth Rockwood 67 889 * Your ultimate goal is to gradually build up to 7,500-10,000 steps/day.

Frequency {days/weck): J1 [ 3 24 a5 - a7
What about strength training?

* You don't have to go to a gym. "Lty elastic bands, do body weight exercises (chair sit-to-
olunks or bridges) or lift dumbbells,

starids;
Heavy work around your home or yard s

sor, wall or Kitchen counter push
ds strength.

= Strengthen your legs, 'I ack, chest and arr To stare, try 10-15 n:|-q'_i!'1un-».' using light effort.
Build up to medium o r'hlni etfort for 8-12 repetitions. Repeat 2-4 times, 2-3 days/weelk,

* Give yourself a rest day between each strength training session.

Prescriber’s Signature: I
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The most compelling evidence is related to MeDI with

increased consumption of food items rich in:
- vitamin E (nuts), acting as an antioxidant,

- fish, - B12 vitamin, - folates

- showing dementia risk reduction of 20-40%

Systematic review of 56 studies (population/RCT),

- higher adherence to all predominantly WFPB dietary
patterns

- associated with significantly lower dementia risk ~50%

- even moderate adherence reduced dementia risk by 35%




The Overweight/Obesity Spiral

$ Weight Gain

Aggressive —

Marketing of

Unhealthy Food % Cardiovascular
disease

Premature Diabetes
Death Cancer
Arthritis
% Junk Food

Dementia

| Physical Activity

tTV
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Make water
your drink
of choice

The American Journal of Clinical Nutrition
Available online 18 January 2024

ELSEVIER In Press, Corrected Proof  (7) What's this?

HEALTHY EATING PLATE

. =

ER

Eat whole grains (like brown
rice, whole-wheat bread,
and whole-grain pasta).

Use healthy oils (like
olive and canola oil)
for cooking, on salad,
and at the table. Limit
butter. Avoid trans fat.

Drink water, tea, or coffee
(with little or no sugar).
Limit milk /dairy

(1-2 servings/day) and
juice (1 small glass/day).
Avoid sugary drinks.

The more veggies—
and the greater the

variety—the better.
Potatoes and french fries

don't count. Limit refined grains (like
HEALTHY white rice and white bread).

Eat plenty of fruits of

all colors. Choose fish, poultry, beans,

and nuts; limit red meat;
avoid bacon, cold cuts, and
other processed meats.

“ proren

Harvard Medical School EETS
Harvard Health Publications '-‘:;‘ks

www.health.harvard.edu

-3
& STAY ACTIVE!

0 Harvard University

m £ & Harvard School of Public Health
‘Gl The Nutrition Source
www.hsph.harvard.edu/nutritionsource

Original Research Article

Effect of multivitamin-mineral
supplementation versus placebo on
cognitive function: results from the clinic
subcohort of the COcoa Supplement and
Multivitamin Outcomes Study (COSMOS)
randomized clinical trial and meta-analysis
of 3 cognitive studies within COSMOS

Chirag M Vyas! 9 &, JoAnn E Mansen ? * %, Howard D Sesso ? %, Nancy R Cook 23,
Pamela M Rist % 3, Alison Weinberg %, M Vinayaga Moorthy 2, Laura D Baker ° &,
Mark A Espeland ° 7, Lok-Kin Yeung ®, Adam M Brickman ® * '°, Olivia I Okereke '** 2 =

Don’t Forget

FLAVOR




Alzheimer’s
&

Dementa

Alzheimer's & Dementia 11 (2015) 1007-1014

ELSEVIER

Featured Articles

MIND diet associated with reduced incidence of Alzheimer’s disease

Martha Clare Morris™*, Christy C. Tangneyh, Yamin Wang", Frank M. Sacks",

David A. Bennett™. Neelum T. Agearwal™®
e o o 8

LOWER YOUR RISK OF ALZHEIMERS DISEASE

° N :923 ';m!'_;,mm ..... e U T ey
* Age 58-98 i o= o

10 BRAIN HEALTHY FOOD GROUPS g

%»ttbﬂ

* 4.5years

. Green Leafy Other
. :  Vegetables ngntahlas Berries Olive Oil
e DASH + Mediterranean /
. - O @& e
e One glass Of wine 5 = i Tes i :
DAILY MOST DAYS TWICE 5 UNHEALTHY
1 s e PER WEEK FOTOg f‘;?glg"s
TS POULTBY RED MEATS
® 5 3 (y d d é BEHHIES BUTTER &
o reduction in incidenc oyt onceons [T
S0t el fenicnibay, WEEK i
1 cuass oFwine i i FRIE:;SFT::(SFDDD

Alzheimer's Disease is the 6th leading cause of death in the United States. Over 5.1 million

American's have Alzheimer’s Disease in 2015 but it is expected to rise to 7.1 million by 2025. This
study only shows an association between a healthy diet and a lowered risk of Alzheimer's.

DiaMedical USA

: F PARTS ONLINE
Providence @; SWEDISH

J Alzheimers Dis. 2021:; 83(2): 683—-692.

CENTRAL ILLUSTRATION: Potential Mechanisms for Olive Oil Intake and
Mortality

Monounsaturated
faty acids R

Phenolic
compounds
(hydroxytyrosol,
oleuropein, ...)

Lipid derivate

molecules (squalene,

tocopherols, ...)

Guasch-Ferré, M. et al. J Am Coll Cardiol. 2022;79(2):101-112.
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The NEW ENGLAND JOURNAL of MEDICINE

“ RESEARCH SUMMARY I|

Trial of the MIND Diet for Prevention of Cognitive Decline
in Older Persons

Barnes LL et al.

CLINICAL PROBLEM

Observational studies have suggested that dietary pat-
terns might affect cognitive decline, but clinical findings
are limited. Most clinical trials of dietary interventions
have focused on cardiovascular health outcomes that
might affect the occurrence of dementia, rather than
focusing directly on cognitive function.

CLINICAL TRIAL

Design: A two-site, randomized, controlled trial assessed
the effects of a 3-year dietary intervention on cognitive
decline and brain imaging markers of dementia and
Alzheimer's disease in older adults without cognitive
impairment but with a family history of dementia.
Intervention: 604 adults 265 years of age who were over-
weight, had suboptimal diets, and had a family history
of Alzheimer's dementia were assigned to follow the
Mediterranean-DASH Intervention for Neurodegenerative
Delay (MIND) diet (a hybrid of the Mediterranean diet
and the Dietary Approaches to Stop Hypertension diet)
with mild caloric restriction or a control diet with mild
caloric restriction for 3 years. All participants received
counseling regarding adherence to their assigned diet
and support to promote weight loss. The primary end
point was the change from baseline in a global cognition

score (higher scores indicate better cognitive performance).

RESULTS

Efficacy: Global cognition scores improved from baseline
to year 3 in both the MIND-diet group and the control-
diet group but without a significant between-group dif-
ference.

Safety: The incidence of adverse events was similar in the
two groups. The most common events were cardiovascular
and musculoskeletal.

DOI: 10.1056/NEJM0a2302363

MIND Diet Control Diet
(n-30) @ (N=303)

C;f"” /\ Emphasizes plant-based foods, fish, and olive oil
- Limits saturated fat and sugar

Change in Global Cognition Score at 3 Yr

Mean difference, 0.035 standurdized units (95% CI, -0.022 to 0.092), P=0.23

LIMITATIONS AND REMAINING QUESTIONS

Generalizability of the results may be limited by the fol-

lowing features of the trial:

= Participants were required to have a family history
of dementia, to have suboptimal diets, and to be
overweight.

= Participants were predominantly well-educated, older
adults of European descent.
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z
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MIND Diet Control Diet

CONCLUSIONS

Among older adults without cognitive impairment but
with a family history of dementia, cognitive function at

3 years did not differ significantly between those who
followed the MIND diet and those who followed a control
diet with a mild caloric restriction.
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A Variety of Traditional Diets
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Mediterranean Diet increases life
expectancy

Greatest gains in young adults- can add

up to 13 years

At age 60 can add 8+ years

At age 80 can add 3.5 years
Largest gains from: more legumes, whole
grains and nuts, and less red and
processed meat

Fadnes LT, @kland J-M,. Haaland @A, Johansson KA (2022)
PLoS Med 19(2): 1003889



How to Implement

Assess needs/preferences/willingness of others
Especially the grocery shopper

Referral to dietician/nutritionist/ vSMAs delish
Consider incremental changes

Harm reduction model

Pre-packaged meals

Consider different textures, spices, plate to food
contrast

Importance of routines, consistent table settings

Consider involving company or family

hitps://oldwayspt.org/recipes
hitps://www.gaplesinstitute.org/
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Cognitive Training and Stimulation

K AMSTAR Hedge's g (95% CI)
Older adults
Papp et al (2009) 10 35 Critically low | | 016 (0-14 to 0-19)
Metternich et al (2010) 4-5 & Critically low S E— 0-48 (0-23t0 073)
Martin et al (2011) 2-11 & Critically low ] 0-47 (-0-44to 1-38)
Gross et al (2012) 35 65 Critically low = 031({02210 039)
Hindin et al (2012) 25 35 Critically low —.— 0-33 (013 t0 0-52)
Karr et al {2014) 15 85 Critically low — . 026 (010 to 0-42)
Kelly etal (2014) 2-7 g Critically low —_— 038 (00510 072)
Lampit et al (2014) 51 12.5 Moderate - 022 (015 to 0-29)
Toril et al (2014) 20 6 Critically low —— 032 (019 to 0-45)
Shao et al (2015) 6-10 4] Critically low RN E— 031 {005 to 0-57)
Melby-Lervag et al (2016) 17 1 Critically low | 013 (-002to 0-28)
‘Wang et al (2016) g 85 Critically low - B 0-38 (012 to 0-64)
Weicker et al (2016) 10-20 65 Critically low — 0-38 (014 to 062)
Chiv etal (2017) 6-22 7 Low e 0-32 (016 to 0-48)
Mewbarn etal ( 2017) 48 9 Moderate - 031(024to 0:39)
Smart et al (2017) 8 75 Critically low R E 037 (0-05 to 0-69)
Tetlow etal (2017) 314 4 Critically low — 016 (-011t0 0-43)
Bhome et al 2018) 10 8 Low - 013 (0-01 to 0:25)
Gates et al (2019a) 2-4 12.5 Low . » 0-64 (-0-56 to 1-85)
Mild cognitive impairment
Sherman et al (2017) 26 8 Low —_— 045 (0-16 to 0-75)
Martin et al {2011) 2-3 4] Critically low L 0-60 (0-00to 1-19)
Wang et al (2014) 3-6 8 Critically low 4 =m 032 (-0-04 to 0-69)
Hill et al {(2017) 17 12 Moderate —— 035 (0-20 to 0-50)
Mewbarn et al (2017) 12 9 Moderate —a— 034 (0-21to 0-47)
Gates et al (2019b) 25 125 Low » 0-41(-022 10 1.04)
Dementia
Huntley et al (2015) 3 11.5 Moderate — & 028 (-0-12to 0-68)
Kurz et al (2011) 5-12 6 Critically low —_— 026 (0-08 to 0:43)
Woods etal (2012) 14 105 Moderate — 0-41(0-25 to 0.57)
Huntley et al (2015) 2-17 1ng Moderate R 035 (0-11to 0-58)
Folkerts et al (2017) 2-3 105 Low s 0-35 (0-05 to 0-65)
Kim etal (2017) 1 7 Critically low —— 0-44 (0-28 to 0-60)
Alves et al (2013) 2-3 12 Low . 009 (-0-36 to 0:54)
Karr et al (2014) 10 85 Critically low J 020 (-0-07 to 0-47)
Huntley etal (2015) 3 115 Moderate | 022 (-074to 118)
Song etal (2016) 3-6 2.5 Critically low R — 033 (014 to 0:53)
Folkerts et al (2017) 2 105 Low > 116(053t01-79)
Hill et al (2017) 1 12 Moderate —————— 026 (0-01to 0-51)
Bahar-Fuchs et al (2019) 26 14 Moderate s S— 042 (023 to 0-61)
—- Cognitive training
—&— Cognitive stimulation f T T 1
8- Mixed cognition-oriented treatments =05 ] 0.5 1.0 15

+— —>r
Favours control - Favours intervention

Figure 3: Pooled results of
meta-analyses investigating
objective cognitive
outcomes of cognition-
oriented treatment in older
adults with and without
cognitive impairment

K represents the number of
primary trials incduded in the
analysis. If a review reported
several effect sizes within each
outcome domain, a compaosite
was created and k denotes the
range of the number of
primary trials that contributed
to the effect estimate.
AMSTAR=A MeaSureament
Tool to Assess systematic
Reviews (max score 16).
Adapted from Gawvelin et al,>*
by permission of Springer
Mature.
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How to Implement: LIFELONG
NING

Engaging in a vqueA IS:u:hvmes that challenge memory, language, spatial reasoning,
attention, etc.
Tasks emphasizing processing speed may most helpful (Rebok et al, 2014, JAGS)

The difficulty should be adjustable to gently but consistently push your skills (without being
too frustrating or discouraging)

Activities done as a group or with a partner

Activities that involve new learning (i.e., a new card game, language, instrument, lecture
series)

At least a hour a day of things that keep your mind active, like reading, socializing, games

Some pre-packaged, computerized programs include:

Posit SC|enc:e / Brain HQ - h_’rlm //www.brainhg.com/
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https://www.brainhq.com/
https://www.lumosity.com/
https://stayingsharp.aarp.org/about/brain-health/games/

ORIGINAL ARTICLE

A Comparison of Two LDL Cholesterol Targets after Ischemic Stroke

Pierre Amarenco, M.D., Jong S. Kim, M.D., Julien Labreuche, B.S.T., Hugo Charles, B.S.T., |érémie Abtan, M.D., Yannick Béjot, M.D., Lucie Cabrejo, M.D., |ae-Kwan Cha, M.D.,
Grégory Ducrocg, M.D., Ph.D., Maurice Giroud, M.D., Celine Guidoux, M.D., Cristina Hobeanu, M.D., et al., for the Treat Stroke to Target Investigators*

Article  Figures/Media Metrics January 2, 2020
N Engl | Med 2020; 382:9-19

™

Life’s .
Essential
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Multidomain Interventions FINGER study
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Baseline 12 months 24 months Basetine 12 months 24 months

A combination of lifestyle interventions prevents or slows down cognitive decline

P.['O\fidence @ SWEDISH Presentation Title

N%andu et al, Lancet, 2015

ere > Insert > Header & Footer 2



Cognitive Checklist/Plan

Labs: B12 + TSH, routine studies

Screen questions: EtOH + depression

Other: Sleep apnea + hearing

J
J
d Meds: Benzos, Ambien, oxybutynin, benadryl
J
loss/cataracts/sensory challenges

u In;aging: MRI with hippocampal volumes (dx
MCI

PIUVidence 3= SWEDISH Presentation Title Here > Insert > Header & Footer



Loneliness and social isolation - now and in the future

PY (5] ) 3.9m ®
3.4m 2018 * U
@ 2008
. aged 65+ aged 65+ aged 65+ aged 65+ As our population ages, the
Vl ve k H . M urt hy, M D Afairly constant proportion Nearly one in three In later life, loneliness is most 2018, 3.9 million people absolute number of lonely older
(6—13%) of people aged 65+ who have experienced common amongst the oldes + were living alone in peopleis likely to increase
19TH SURGEON GENERAL report feeling lonely often partner bereavement increase of halfa
million people since 2008

or always report being very lonely

Life circumstances Impacts
linked to loneliness and social isolation of loneliness and social isolation

OF THE UNITED STATES

Loneliness:

I h Retirement P ical a
O ‘ t ‘ I Poor physical and - key risk factor for depression in older age
mental health - linked with a 40% increased risk of dementia
Bereavement
Social isolation:

Poverty Living alone - strongly linked to cardiovascular disease

Loneliness, social isolation, and living alone are all associated with an

W % Caring for somebody increased risk of early death.

The Healing Power of

Human Connection in a

Sometimes Lonely World > Neurology. 2022 Jul 11;99(2):e164-e175. doi: 10.1212/WNL.0000000000200583.

Associations of Social Isolation and Loneliness With
Later Dementia

Chun Shen ', Edmund T Rolls ', Wei Cheng ', Jujiao Kang ', Guiying Dong !, Chao Xie ',
Xing-Ming Zhao 1, Barbara J Sahakian 1, Jianfeng Feng °

Fresentation |itle Here > Insert > Header & Footer
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Participants with APOE €4

- (0))

Dementia Incidence (%)
N

o

Positive
Age Beliefs

j - F
Providence @ SWEDISH

Negative

All Participants

Positive Negative
Age Beliefs

Fig 1. Positive age
beliefs associated with
reduced dementia
among participants
with APOE ¢4 and all
participants.

Levy BR, Slade

MD, Pietrzak RH, Ferrucci L (2018)
Positive age beliefs protect against
dementia even among elders with
high-risk gene. PLOS ONE 13(2):
e0191004.
https://doi.org/10.1371/journal.pone.01
91004
http://journals.plos.org/plosone/article?id

=10.1371/journal.pone.0191004

Breaking the Age Code by B Levy PhD
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MBI’s and Gene Expression

MBIs --Mindfulness,
Yoga, Tai Chi, Qigong,
relaxation response, and
breath regulation

Reduced signalling of NF-
kb — key transcription
factor that leads to stress
related gene expression
for inflammation

Bower & Irwin, 2016, N = 26 trials)
Buricet al, 2017, N = 18 trials



https://www.mindfulpublichealth.org/
https://www.mindfulpublichealth.org/

Finding Your Mission, Aspiration, Purpose (MAP)
« Mission: An important goal accompanied by strong conviction
« Aspiration: A strong desire, longing, or aim

« Purpose: The reason why something exists, is done, is made, or is used

I/‘
MAP o
:
S

—  What matters most in life

— Your priorities in life

— Your vision of your optimal life and health

Having a purpose improves our
health

P I‘OVidence 3= SWEDISH Presentation Title Here > Insert > Header & Footer 2



The Most Important Questions for Change

e Is it worth it? e CanIdoit?

PI‘OVidence @ SWEDISH Presentation Title Here > Insert > Header & Footer 2



Brain Health Rx

O Medications: deprescribe/avoid sedating
and anticholinergic.

O Contributing Conditions: Sleep apneaq,
hearing loss, poor vision, depression, frailty.

O Exercise: >150 min/week aerobic
& strength training twice/week.

L

Stress Resilience/Mindfulness-try HealthyMinds
hitps://hminnovations.org/meditation-app

Cognitive & Social engagement

Nutrition Mediterranean/ MIND/ WFPF
Alcohol: Limiting 0-1 drinks, no smoking/drugs
Blood pressure SBP <120

Lipids LDL <70 if prior TIA or stroke ‘ ADHE;&Spms

o 0 0 o0 0 O

Blood Sugar Alc < 5.6 w/o DM, <7 w/ DM2
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https://hminnovations.org/meditation-app

IHC Whole Person Care Grant

As part of the VSMA,
patients will receive
ingredients to cook SR
along with the nutritionist N Y

during the vSMA N |
appointment as part of
TKC.
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Resources/references:

hitps://www.nia.nih.qgov/health/exercise-physical-activity

https://www.youtube.com/playlist?list=PLmk21KJuZUMA4HTrJ7hrJ)8
vxXhToKkJT8a8

hitps://www.thelancet.com/article/S0140-6736(20)30367-
é /fulltext

https://n.neurology.org/content/95/4/e374
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https://www.youtube.com/playlist?list=PLmk21KJuZUM4HTrJ7hrJ8yxhToKkJT8a8
https://www.thelancet.com/article/S0140-6736(20)30367-6/fulltext
https://www.thelancet.com/article/S0140-6736(20)30367-6/fulltext
https://n.neurology.org/content/95/4/e374

Thank you for your attention!

S stands for 7-8 hours sleep, which serves to clear away Alzheimer’s pathology.

H is for handling stress, for example, with a meditation practice, movement.

| is for interaction with friends. Loneliness doubles risk for Alzheimer’s.

E is for exercise, which induces new nerve cell growth to strengthen brain regions affected in
Alzheimer’s disease.

L is for learning new things, which increases the number of synapses in your brain, the connections
between nerve cells storing your memories. Synapse loss correlates most with the degree of dementia.
The more synapses you make, the more you have to spare.

D is for diet. The best diet for the brain is the WFPF diet, which minimizesred meat and isrich in fiber
from fruit and vegetables that strengthens bacteria in your gut, or your gut microbiome. A healthy gut
microbiome has also been shown to reduce brain neuroinflammation, the biggest killer of nerve cellsin

the brain.
Questions?
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Swedish Neuroscience Institute

1600 Jefferson Ave

Seattle, WA

Ph. 206-320-7200 fax 206 320 2560
Nancy.lsenberg@Swedish.org

https://www.swedish.org/locations/center-for-healthy-aging
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Contact Information

You start dying slowly

if you do not travel,

if you do not read,

If you do not listen to the sounds of life,
If you do not appreciate yourself.

You start dying slowly
When you kill your self-esteem;
When you do not let others help you.

You start dying slowly

If you become a slave of your habits,

Walking everyday on the same paths...

If you do not change your routine,

If you do not wear different colours

Or you do not speak to those you don’t know.

You start dying slowly

If you avoid to feel passion

And their turbulent emotions;
Those which make your eyes glisten
And your heart beat fast.

You start dying slowly

If you do not change your life when you are not satisfied with your job, or with your love,
If you do not risk what is safe for the uncertain,

If you do not go after a dream,

If you do not allow yourself,

At least once in your lifetime,

To run away from sensible advice...

Start living today

Run risks today

Do something today

Do not allow yourself to start dying slowly
Do not forget to be happy"

Author: Pablo Neruda - Nobel Prize Winner 1971
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